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 14
Reporting for results

There are so many reports in MYOB that it’s sometimes hard to know where 
to begin. After all, what’s the difference between a Sales Customer Detail 
report, an Analyse Sales Item report and a Sales Register Detail report? 
If you feel a little daunted by this choice, start with the Business Insights 
menu (found on the bottom-right of every MYOB command centre), where 
you’ll find all essential financial reports grouped together.

 Golden rule
For quick, intuitive reports, go first to your Business Insights menu. 

After you familiarise yourself with the Business Insights menu, you’re ready to head 
for the main Reports menu. The easiest way to see what a report does is simply 
to pick a date range and display the report to screen. Remember that you can 
customise both the format and the content of most standard reports, by changing 
fonts and colours, filtering data or sorting your report in different ways. Even better, 
once you’ve got a report how you want it, you can save these custom settings, 
ready for next time. 

If you want to manipulate reports even further, you can send reports to Excel. 
From Excel, you can format reports in whatever way you like: add columns, insert 
formulae, or cut and paste sections from one report to another. Or, maybe you 
need to calculate commission for salespeople, generate a livestock report for your 
farm, or produce work-in-progress reports? The possibilities are limitless.

Report customisation features changed substantially with the latest releases of 
AccountRight, and this chapter also explains the new features that came with this 
upgrade.

Discovering where reports live
For most newbies to MYOB, the most obvious place from which to generate reports 
is the Reports menu. This menu offers over 120 standard reports, each one of which 
can be customised. However, don’t forget that sometimes a report isn’t the quickest or 
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smartest way to look up information. Other good sources include your lists, transaction 
registers and the Business Insights menu. Questions 14.1 to 14.3 cover not just the 
Reports menu, but these alternative sources also. 

14.1 Where do I go to find reports?
Check out what each of these different methods offer:

•	 The Reports menu: To see all available reports in one compact list, go to your 
Reports menu, found either on the bottom of every command centre or from 
the Reports menu on the top menu bar. You’ll arrive at a screen that will look very 
similar to Figure 14-1. Reports are sorted according to the different command 
centres, so that you can click any of the tabs to see a different list of reports. All 
of these reports can be customised to suit your needs. Questions 14.4 to 14.7 
explain how to modify the actual information on your report, and questions 14.8 
to 14.13 explain how to change the formatting.

 Figure 14-1 Go to your reports menu for a complete list of all available reports

•	 The Find Transactions menu: If you want to look up transactions for a particular 
customer or supplier, the Find Transactions menu is actually much quicker than 
any of the customer or supplier reports. Select Find Transactions from the 
bottom of any of the command centres, click the Card tab, enter the customer 
or supplier name along with a date range and there you have it: a complete list 
of transactions.

•	 Lists: Lists are ideal for looking up individual customer, supplier or item details, or 
for sorting information in particular ways (for example looking up all customers 
according to postcode or amount owed). See question 14.2 for more info about 
manipulating lists. 
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•	 The Sales Register, Purchases Register and Bank Register: The Sales and 
Purchases Registers are the best spot to investigate quotes, orders or credit notes, 
and to get a quick synopsis of the history of a particular customer or supplier. The 
Bank Register is a neat way to view withdrawals and deposits for any chosen bank 
account. See question 14.2 for more info about working with registers. 

•	 The Business Insights menu: For a quick synopsis of the health of a business, go 
to the Business Insights menu found in the bottom-right corner of any command 
centre. See question 14.3 for more info.

14.2 Can I change what I see in the lists or transaction registers?
Yes, you can, and often lists and registers provide the quickest way of looking up 
information.

Way back in Chapter 2, question 2.20 explains how you can manipulate lists to 
view information in different ways. You can sort by column, create groups, remove 
columns or display extra columns and lots of other neat things.

The features are a more limited for registers than they are for lists, but the main 
thing to remember is that the Sales Register is a great place to look up information 
about customer sales, just as the Purchases Register is a great place to find info 
about supplier bills and purchase orders. Remember that with the latest versions 
of AccountRight, you can also sort by any column in the registers. For example, if 
you go to your Sales Register, you can click the Amount Due column to make the 
invoices with the highest value appear at the top.

14.3 What about modifying the Business Insights dashboard?
As mentioned in question 14.1, the Business Insights dashboard (accessed from the 
bottom-right corner of any command centre) is a quick way to check out business 
profitability and analyse sales, bank accounts or outstanding payables.

You can control, to a limited extent, what appears on the dashboard. For example, 
go to Business Insights and select the Customer Analysis tab. Then click the little 
Customise button in the top-left corner. You see a window similar to Figure 14-2. 
From here you can choose to remove panels that aren’t relevant to your business, 
or add panels that are. 



Chapter 14  Reporting for results 275

Figure 14-2 Choosing what you want to appear on your Business Insights dashboard

Within each pane, you can also choose to group information in different ways. For 
example, go to the Bank Accounts pane under the Account Details tab, and right-
click the Type column label and select Group By This Column. This action groups 
each type of account together. You can then click the little plus button on the left-
hand side to expand any one of these groups and view the details within. 

Last, don’t forget that when working with the Business Insights dashboard, you 
can click any column label to sort by that column. For example, click the Total Due 
column to show the customer who owes the most at the top of the list; click the 
Invoice No. column to sort by invoice number; or click the Overdue Days column 
to show the most overdue invoices at the top. 

 AccountRight upgrade
Although you can’t manipulate the graphs in the Profitability Analysis, what you can do 
is right-click on any of the four images and save the image as a jpg file. This way, you 
can then insert the image into management reports.

Changing the information on reports
This next section talks about working with MYOB’s standard reports (all of which you access 
from the main Reports menu) and how to change the information that appears on these 
reports. To view the list of standard reports, either select Reports from the top menu bar or 
go to the Reports menu that appears on the bottom of each command centre. You arrive 
at a menu very similar to Figure 14-1.



276 Making the Most of MYOB AccountRight

Click Display to see the default format for whichever report you’ve chosen, usually with the 
current month as the date range. The next step is to transform this report into a document 
that gives your business the specific information it needs. 

14.4 How do I change the columns that appear on my reports?
On most reports you can choose which information you wish to include. See how 
this works in practice using a Profit & Loss report as your starting point.

1. Go to your Reports menu, click the Accounts tab and click the Profit & Loss 
[with Year to Date] report. 

2. Make sure the date range is something relevant and click Display.

3. Click the Insert/Modify tab from the top menu bar. 

4. Click the Show/Hide button on the reports toolbar.

5. Start by adding account numbers to this report. Do this by clicking Account 
No. on the left pane, and then click Show to shift this field to the right pane. 
While you’re at it, experiment with hiding the percentage columns. One by 
one, highlight % of Sales and % of YTD Sales and click Hide to shift these 
fields to the left pane.

6. Click OK and observe how your report has changed.

You can apply this principle to any standard report. In other words, you display the 
report, you go to the Insert/Modify tab, and then you click the Show/Hide button 
in order to choose which columns you want to show on the report.

Figure 14-3 Adding or deleting fields in your report
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 Tip
If a report prints out with lots of zero values and these zero values get distracting, you 
can simplify things. First display the report, then click the Filters tab. Unclick the option 
to Include Zero Balances.

14.5 Can I narrow my report to just reports on certain items, 
customers, or sales?
All standard reports come with the maximum amount of information. For example, 
a sales report is going to list sales to all customers, including all items sold and all 
salespeople. But what if you want to narrow down this report to only list some 
customers, certain items or particular salespeople? You do this by applying report 
filters.

Opening a sales report provides an excellent way to see how this works.

1. Go to the Sales tab of your Reports menu and select the Sales [Customer 
Detail] report.

2. Select a date range that you know contains some sales, then click Display.

3. Click the Filters tab.

4. From the Customers menu, click the drop-down arrow and then click against 
the customers you want to include in this report.

5. Change the Sales Status to All Sales. (All Sales includes quotes and orders, 
whereas All Invoices displays actual sales only.)

6. Click the Additional Filters button and decide whether you want to restrict the 
information on this report in any other way. For example, you could choose 
to only display amounts over $1,500, or sales made by specific salespeople, 
or sales sent by a particular courier. Each additional filter further narrows the 
content categories displayed in the report.

7. Check out the results. 

Applying these report filters works well, doesn’t it? Although this example refers to 
a sales report, you can apply these concepts to every single report. Simply go to the 
Filters tab and see what options are on offer and if relevant, click the Additional 
Filters button also.

14.6 How do I sort the information on my reports?
Similar to many of the features mentioned so far in this chapter, the sorting feature 
is new to the latest versions of AccountRight and is one of those little things that 
really add flexibility to the information you can generate. To sort data in almost any 
way you like, simply go to the Filters tab and click the Sort button.
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Figure 14-4 shows an example. With this Sales Customer Detail report, you can sort 
first by Item or Account Number, and then by Quantity. Alternatively, you can sort 
by Amount, listing the highest value sales first.

Figure 14-4 The Sort feature adds another layer of flexibility to your reports

Of course, you may still hit limitations with the Sort feature. For example, if you’re 
working with a customer sales report and you want to sort the whole report 
according to item codes, rather than customer name, then you can’t, because 
this particular report always sorts first by customer. In this kind of situation, your 
best bet is either to experiment with item reports (which do sort first according 
to item codes) or to send your report into Excel. See questions 14.17 to 14.22 for 
more information.

14.7 I’ve just upgraded. Where are the options that used to live 
under the Finishing tab?
Most of the options that used to sit under the Finishing tab in earlier versions of 
AccountRight now sit under the Filters tab. 

For example, if you display a Profit & Loss report and then go to the Filters tab, you 
can see the options for including zero balances or rounding figures to the nearest 
dollar. These options used to be stored under the Finishing tab.

At the time of writing, not all options that had been under the finishing tab were 
included in the current reports (for example, the Filters tab doesn’t include an 
option to print report sections on separate pages). However, this omission may 
have been corrected by the time you’re reading this.
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Formatting the look of reports
Although printing a report is as simple as clicking the Print button, you can do a few things 
to make your report look heaps smarter. This section explains how to format report headers, 
change report fonts, add company logos and much more. 

When working with report formats, consider whether you are going to print this report or 
whether the report will end up being in electronic format only. If the report is going to be 
printed, you’re usually best to steer clear of colours, as adding colours to reports is expensive 
and not exactly environmentally friendly.

14.8 How do I change the format of report headers, or the name 
of the report?
Every report has a header section which includes your company name and address, 
report name and so on. You can choose which of these items to display by going 
to the Insert/Modify tab of the report and clicking the Fields button. You can also 
change the format of these headers by highlighting the text with a click of the 
mouse and:

•	 selecting the font and font size from the font menu

•	 changing the colour of the text by clicking the artist’s palette icon

•	 changing the colour behind the text by clicking the paint pot icon

•	 changing the background behind the entire report by clicking the Page Colour 
menu.

 AccountRight upgrade
If you hold down the Control key and then click on the fields you want to format, you 
can change more than one field at a time. 

14.9 What about changing the format of the body of the report?
At the time of writing, you can’t make any changes to the format of the body of 
a report in the latest versions of AccountRight, although MYOB have flagged this 
change for future versions.

The only changes you can make to the format of the body are row shading and 
watermarks. To add row shading (a handy feature if you have lots of lines on your 
invoices or orders), go to the Insert/Modify tab and select Show Row Shading 
from the Row Shading menu. This adds a grey background to every alternate row 
on your report.

To add a watermark — maybe you want to add a logo in the background, or write 
DRAFT across a quote or an invoice — go to the Watermark menu and select 
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the stamp you want to emblazon across your report. Alternatively, click Custom 
Watermark to enter your own choice of text.

14.10 Can I add additional text or logos to the top of my reports?
A new feature in the latest versions of AccountRight is the ability to insert text 
boxes, logos and shapes in the header section. To use these features, first display 
the report, go to the Insert/Modify tab, and then:

•	 To add text, click the Text Box button, then drag out the shape of a box where 
you want text to appear. Double-click inside this box to enter the text itself. 

•	 To add a box or a line, click the Shapes/Lines button, position your mouse 
pointer roughly where you want the top left corner of the box or line to sit, and 
then click and drag the bottom corner downwards and to the right (for a box) or 
simply to the right (for a line). To adjust the thickness of boxes or lines, highlight 
the line or shape and then click the paint pot icon, selecting Weight from the 
drop-down menu.

•	 To add a picture, click the Picture icon, navigate to the folder where the company 
logo lives, and click Open. Then drag and drop this logo into position.

At the time of writing, formatting report headers can be a bit glitchy. You can often 
resuscitate things by clicking the Print Preview tab, then returning to the Insert/
Modify tab.

 Advanced tip
Have you ever wanted to change the name of a report? Maybe you want to rename 
your Profit & Loss report so that it’s called an Income and Expenditure report, or rename 
a Sales report so it’s called a Performance report. You can. Go to the Fields button and 
deselect the option to print the report name. Then add a text box in the spot where you 
want the report header to appear, with the name of the report as you’d like to see it.

14.11 Can I move, narrow or widen report columns?
Yes. First display the report and then: 

•	 To narrow or widen a column, rest your mouse on the column divider in the top 
section of the report body. Click then drag your mouse gently to the left or right.

•	 To move a column to another position (maybe you want to display the Date 
column before the Invoice number column or something similar), rest your 
mouse on the column header and then drag your mouse gently to the spot 
where you want this column to live, and let go. Alternatively, go to the Insert/
Modify tab and click the Order button. Highlight the column you want to move 
and click the up or down arrow. 
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14.12 How can I get everything to fit neatly on the page?
If you have too many columns for everything to fit neatly, consider either removing 
columns that you don’t need (refer to question 14.4 to find out how) or changing 
the report to Landscape orientation (select Landscape from the Orientation menu 
while on the Print Preview tab).

If this doesn’t do the trick, you may want to try scaling your report, say printing it at 
80% or 90%, or clicking the Shrink to One Page icon. (Both these settings are found 
on the Print Preview tab.)

You could also try tweaking the margins by selecting Narrow from the Margin 
menu (also found under the Print Preview tab).

14.13 What about bar graphs and pie charts?
The only reports in graph format are to be found under the Business Insights menu. 
However, these graphs are pretty limited in that you can’t really manipulate the 
data (for example, although you can produce a bar graph plotting sales for the 
current financial year, you can’t create a bar graph that plots sales for the last six 
months only).

The most practical solution is usually to find a standard report with the information 
you need, and then send this report into Excel and create graphs and charts from 
there. Questions 14.17 onwards explain more about sending reports to Excel. 

Saving and printing reports 
If you recently upgraded to the latest version of AccountRight, you’ll find the custom reports 
work very differently. Custom reports used to live as unique files separate from your company 
file; in the latest releases, custom reports form an integral part of your company file.

The next section of this chapter explains how to save your report filters and formats as 
custom reports, and also how to save your reports as PDF files, ready for emailing to others 
or archiving.

14.14 Can I save my report settings?
Yes. Whenever you make a change to a report’s filters or format, you can choose to 
save this change ready for next time. All you have to do is display the report, make 
the changes you want, and then select Save As from the File menu. Enter a name 
for this report and click Save.

You can find your new report by going to My Custom Reports on the bottom 
left of your Reports menu. (In previous versions, you could also choose to add 
custom reports to the top menu under Reports, but at the time of writing this 
feature isn’t available.)
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Because custom reports now form part of your company file, you can no longer 
share custom reports between company files in the same way as you could with 
earlier versions. The only solution is to create custom reports from scratch for each 
company file. 

14.15 Why have all my custom reports disappeared?
If you’ve recently upgraded to the latest version of AccountRight, then you’ll find 
that all your custom reports have disappeared. The solution? Sadly, there isn’t one. 
You simply need to knuckle down and recreate these reports. (In previous years, 
you could upgrade custom reports from one version to another, but this isn’t 
possible with the 2011/12 release.)

14.16 Can I save my reports as PDF files, or send reports  
via email?
You certainly can. To save a report as a PDF file, go to File, select Export and Send, 
click Export on the middle panel and then click the PDF icon on the right-hand 
panel. Think up a name for your PDF file, navigate to a folder where you want to 
store this report and click Save. (Why not create a folder called ‘Reports’ on your 
hard drive, and within that folder have subfolders called ‘June’, ‘July’, and so on?)

To send a report as an email, you have two choices. If you want to email your report 
to more than one person or if you want to format your email message, save the 
report as a PDF first and then attach it to an email. Alternatively, display the report 
first, then go to File, select Export and Send, click Send on the middle panel and 
then click PDF, Excel or XPS on the right-hand panel. Complete the email recipient 
details when prompted and click Send.

 Tip
Don’t waste time and resources collating, filing and storing reports that nobody ever 
reads. Instead, save your reports as PDF files wherever possible. For example, don’t 
print Bank Reconciliation reports anymore but instead save these reports as PDF files, 
storing them in a folder that gets backed up regularly.

Sending reports to Excel
Before telling you how to export reports to Excel, it’s worth sounding a warning: don’t confuse 
exporting reports with exporting data. When you export data you are exporting transaction 
details or customer details, account numbers or inventory items. When you save reports as 
files, you are simply saving the report, not the transactions that make up that report. 

Exporting data tends to work best if you want to manipulate lists using Excel (updating 
item price lists, updating customer lists and so on). Wherever possible, use the Export Data 
menu to copy data into other applications, as opposed to saving data as a file. For example, 
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if you need to get your customer address list out of your MYOB company file, it’s preferable 
to export your customer cards, rather than save your Address List report as a file. See Chapter 
21 for further details.

14.17 How do I send reports to Excel?
One of the easiest ways to get a report exactly how you want it is to send it to Excel. 
Here’s what to do:

1. Start by customising your report within AccountRight, changing date settings 
and available fields so that the report is close to what you want it to be.   

2. Go to the File menu, select Export and Send on the left pane, select Export 
on the middle pane and then click the Excel button on the right pane. Excel 
should open automatically, load the template and display the report. 

3. You can then change report titles, cut and paste columns or rows, add colours, 
convert the report to graphs, or whatever you like! (You’ll probably want to 
tweak the format, as the format of these standard templates is usually ugly 
beyond belief.)

 Figure 14-5 You can send any report to Excel

 Advanced tip
To search for a particular word or string of text in your company file, send a complete 
transaction report to Excel and use Excel’s Find feature. 

14.18 What if I don’t have Excel but use a different spreadsheet?
First display the report, then go to the File menu, select Export and Send on the 
left pane, select Export on the middle pane and then CSV on the right hand pane.

Save this file when prompted and then open it in your spreadsheet software. You’ll 
have to convert the commas to columns when prompted, and the process is a tad 
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fiddly, but at least you’ll be able to get your data out of your company file and into 
a spreadsheet.

14.19 Why aren’t the totals in my Excel report working?
When you send a report from AccountRight software to Excel, be aware that not all 
totals carry across as formulae. For example, if you have a sales report with a total 
at the bottom, you will find that the total is simply a number field, rather than a 
formula adding up all the cells above. 

If you want to change figures on this report, you first have to ensure that all the 
column totals are formulae. If they’re not, then you’ll have to add your own (sorry, 
this book doesn’t double as an Excel user guide, you’ll have to make your own way 
on this one!).

Another problem you may encounter is that the formulae are all correct, but the 
column totals still aren’t updating automatically. If this is the case, check your 
Excel options. 

•	 In Windows Vista or Windows 7, go to the Office or File button and select 
Excel Options, followed by the Formulas side menu. Make sure that workbook 
calculations are set to Automatic, not Manual.

•	 In earlier versions of Windows, go to Tools, Options and click the Calculation 
tab. Make sure that all calculations are set to Automatic, not Manual. 

•	 On a Macintosh, go to Preferences, click the Calculation tab, then the Automatic 
button. 

14.20 Why do I keep getting error messages when I send reports 
to Excel?
Sometimes, the link between Excel and AccountRight software doesn’t work first 
time. The link crashes, you get runtime errors, or the Excel icon is dimmed and 
won’t respond. Here are a few things that can go wrong, along with their solutions:

•	 The Excel icon is dimmed. If you installed Excel after you installed AccountRight, 
then you’ll need to reinstall AccountRight.

•	 The Excel icon is dimmed, and you’ve already reinstalled AccountRight. Start 
by reinstalling Excel, and agree to the default folders Microsoft suggests during 
the install process. Once complete, reinstall AccountRight one more time.

•	 Run Time Error 1826 or 5922. You need to obtain a small file called myobmain.
dot to fix this problem. Contact Technical Support and they’ll email you the file.

•	 General Protection error. Never exit AccountRight while in the middle 
of exporting reports. If you do exit before all report information has been 
transferred to Excel, you’ll get a General Protection error.
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•	 The Excel template can’t be found. Don’t change the file names or location of 
any Excel templates. In new versions, the file path is C:\ProgramData\MYOB\
AccountRight\Reports\Spreadsheet. In older versions, the files live in the 
Spredsht folder under your MYOB program folder. 

•	 Dollar amounts appear as text, dates appear as odd numbers. If you design 
a report or add or subtract columns in the report, the template format may not 
match up with the report. You could have dollar amounts in text-formatted 
fields, dates in dollar-formatted fields, and so on. To fix this, you’ll need to edit 
the Excel template or change the design of the MYOB report.

•	 Nothing at all happens. Your virus protection software may be preventing 
AccountRight software from sending the report to Excel. Check the script 
blocking settings on your virus software and try again. 

•	 You get a message saying ‘Error in OfficeLink process’. This error may be due to 
the OfficeLink drivers failing to register with Windows. To correct this, try clicking 
on the Windows Start menu and select ‘Run’. Type in the following commands 
(each command needs to be run separately): c:\Premier19\drvxl32.exe/register; 
c:\Premier19\drvwd32.exe/register. You may need to change the above folder 
name from Premier19 to your version of MYOB (wherever your version of MYOB 
is installed).

•	 You get a message saying ‘Unable to locate the necessary files to perform 
this OfficeLink function’. Close AccountRight and navigate to where MYOB is 
installed on your C drive.  Locate the drvwd32 file. Right click on the icon, choose 
Properties and in the Compatibility tab, and tick the box for Run this Program as 
an Administrator.  Do the same for the drvxl32 file.   

•	 You’re using the 64bit version of Office 2010. At the time of writing, this version 
of Office 2010 isn’t supported.  

•	 You lose the last half of your report. If sending a really big report to Excel, try 
waiting for a few minutes before you try to view the report in Excel. 

14.21 Can I modify the Excel templates?
Yes. For every report in AccountRight, there’s a corresponding Excel template, 
which you’ll find in the Spredsht folder of your MYOB program folder. You can 
identify Excel templates because they all end with the letters ‘xlt’, whereas regular 
Excel documents end with ‘xls’. 

Just open the template in Excel and make whatever changes you want, paying 
attention to the tips below. Be aware that although you can add additional 
worksheets to a template, AccountRight will only send report data to the first 
worksheet in the template. 

Here are some tips to help along the way . . .
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•	 When editing a template, save it as a template (.xlt file); don’t change it to a 
document (.xls file).

•	 If you edit or delete any fields, your changes may not show up in the template.

•	 The field [[BodyTable]] is usually several lines. When you send a report to Excel, 
AccountRight first determines how many lines are in the body of the report and 
then uses Excel’s insert command to insert that many lines into the spreadsheet.

•	 The final version of your customised template should preferably keep its original 
filename, saved as a template, with an ‘.xlt’ extension. If you change the name 
of a template, every time you try to generate the corresponding MYOB report, 
you’ll get a message saying that the template cannot be found, and you will be 
asked to locate the desired Excel template.

•	 For a bit more detail, check out Support Note 1505, available from www.myob.
com.au. 

14.22 What if I can’t get the data I want into Excel?
All the information you record on a daily basis, such as sales, purchases, customers 
and inventory items, is stored in a complex database known as your company 
file. Usually, you can only access and manipulate this information from within 
AccountRight, or by using the OfficeLink feature to send data to Excel. 

However, even with OfficeLink, the full structure and content of all the data in 
your company file remains hidden. You may find that you can’t send the data 
you’re looking for into Excel in the combination that you require. For example, 
you may want to combine information from a sales report with a certain custom 
field on a customer card, or calculate the number of days between delivery dates 
and promised dates, or produce a report that calculates the total new customers 
generated per salesperson each period. 

MYOB ODBC Direct is a feature that lets you unlock all of the data in your company 
file and then access this data using other applications, such as Microsoft Access, 
Excel, Crystal Reports, or any other ODBC-compatible application. You can then 
organise and analyse this data to build exactly the report that you’re looking for.

For more information, see Chapter 21.

 Advanced  tip
If MYOB  doesn’t have the custom report you want, or you can’t create it using MYOB 
and Excel together, then your best option may be to get a custom report written 
especially for you. See question 22.5 for more details. 


